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Installing

WebSphere® Operational Decision Management supports different possible
configurations and execution environments. The installation process is a
combination of laying down files on your computer and going on to configuring
the system for your specific needs.

You can install WebSphere Operational Decision Management using the launchpad,
Installation Manager, or running a silent installation.

Installation overview

The installation overview provides a high-level view of the common steps and
decisions you take as you install and configure WebSphere Operational Decision
Management in your chosen environment.

WebSphere Operational Decision Management is supported on distributed
platforms, and also on z/OS®.

* There is a distributed installer that is used for all platforms: the product
launchpad and Installation Manager.

The launchpad uses Installation Manager to install the prerequisite software and
the WebSphere Operational Decision Management packages.

Note: In a z/OS environment the distributed artifacts are not intended for
production use. The distributed tools are intended for development and test.

¢ System Modification Program/Extended (SMP/E) is used to install additional
required files on the target z/OS machines.

The SMP/E tool installs specific libraries into the installation directories of
Decision Center for z/OS and Decision Server for z/OS.

This installation guide describes how to use the distributed installer. For more
information on the SMP/E installer, refer to the Program Directory PDEF. This
document is part of the WebSphere Operational Decision Management for z/OS
shipment. The physical shipment of the product includes a printed copy of the
Program Directory. You can also download the Program Directory from
www.ibm.com /software /ShopzSeries|

After completing the installation of WebSphere Operational Decision Management,
the final step after the development phase of your project, is to configure your
chosen execution environment on a production server. This post-installation
configuration is necessary, for example, to set up access on the application server,
define databases and enable communication between the various components.

The following figure shows which platform the products are installed on, how they
are installed, and what configuration steps are required post-installation.
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On a distributed platform, the following list of components provides an example of
a WebSphere Operational Decision Management installation:

Table 1. Components on WebSphere Operational Decision Management distributed

WebSphere Decision Server

WebSphere Decision Center

Sample Server

* Rule Designer and Event
Designer: development
environments based on
Eclipse.

¢ Rule Execution Server:
execution environment for
business rules.

¢ Event runtime: execution
environment for event
rules.

* Decision Center Enterprise
Console and Decision
Center Business Console:
authoring environments
for business users to
author, manage and test
their business rules.

¢ Rule Solutions for Office:
an environment for
business users to author
rules in Microsoft Word
and Excel.

* Business Space widgets
including a widget for
Decision Center.

A server to run applications,
samples, and tutorials on
WebSphere Application
Server Network Deployment.

If your chosen execution environment is z/OS, the following list of components
provides an example of a WebSphere Operational Decision Management

installation:
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Table 2. Components on WebSphere Operational Decision Management for z/OS

WebSphere Decision Server for z/OS WebSphere Decision Center for z/OS
* Rule Designer and Event Designer: * Decision Center Enterprise Console and
development environments based on Decision Center Business Console:
Eclipse authoring environments for business users
« Rule Execution Server: execution to author, manage and test their business

environment for business rules on rules.

WebSphere Application Server for z/OS.

Rule Solutions for Office: an environment

 Event runtime: execution environment for fOI: business users to author rules in
event rules on WebSphere Application Microsoft Word and Excel.
Server for z/OS. * Business Space widgets including a

¢ zRule Execution Server for z/OS: widget for Decision Center.

execution environment to run business
rules on a stand-alone server.

Before starting the installation, identify the components that you need to install
and check the prerequisites for installing WebSphere Operational Decision
Management, see [‘Prerequisites” on page 5| There are a number of ways to install
WebSphere Operational Decision Management: typical installations help you install
predefined configurations, and the custom installation helps you customize your
configuration. Take a look at [’Configurations and application server topologies” on|
to understand the possible configurations.

If do not have the prerequisites installed or if you are missing some, see [“Installing
from the product launchpad” on page 6/If you have the prerequisites installed, see
“Running Installation Manager” on page 20.

Typical installations

To help you get started with WebSphere Operational Decision Management, the
distributed installer provides some predefined configurations and profiles for use
on WebSphere Application Server which is installed as a prerequisite for these
configurations.

The installer proposes the following configurations for a typical installation:

* Sample Server installation: Installs the complete WebSphere Operational
Decision Management product, along with the applications and project to run
the samples and tutorials.

* Stand-alone Server installation: Enables you to select the packages that you
want to install, and configures a single server profile on WebSphere Application
Server.

Custom installation

You can also choose to customize completely your installation. You must use
Installation Manager to select the components that you want to install.
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Related information:

[‘Installing from the product launchpad” on page 6|
Use the product launchpad to install WebSphere Operational Decision
Management as well as the prerequisite software.

[“Installing using Installation Manager” on page 16|

In Installation Manager you can choose the packages and components of
WebSphere Operational Decision Management that you want to install and for
which you have a license.

Configurations and application server topologies

4

Before installing WebSphere Operational Decision Management, it is important to
consider how you want to use Decision Center and Decision Server, and whether
you plan to configure them on an existing production server.

Several components of WebSphere Operational Decision Management, such as
Decision Center, Rule Execution Server, Business Space, as well as the decision and
event widgets require some configuration to work on a production application
server.

WebSphere Application Server V8 can be installed to demonstrate the products, see
[“‘Sample Server: development, test, and tutorials.”| You can also choose to use the
components on a stand-alone WebSphere Application Server profile, see
[“Stand-alone Server: development and production.”| If you already have an
application server that you want to use for any reason, you can manually deplo
and configure the components on an existing instance or in a cluster, see
fconfiguration: development and production” on page 5

Sample Server: development, test, and tutorials

The Sample Server is the default option for developing, testing, and running
samples and tutorials. This option is not for production use.

The Sample Server is a profile on WebSphere Application Server V8 that contains
the deployed components and applications to run the samples, tutorials, as well as
the Getting Started tutorials. You can use the Sample Server to test the different
features of WebSphere Operational Decision Management. This configured server
includes an embedded Apache Derby database and WebSphere Application Server
default messaging as the messaging provider.

The Sample Server does not require any configuration. The profile is created the
first time that you start the Sample Server after installing the product.

Stand-alone Server: development and production

You can use the Stand-alone Server option for development or small-scale
production environment. This simple topology installs WebSphere Operational
Decision Management on a single WebSphere Application Server stand-alone
server. It is not configured for clustering.

When installing through the launchpad, this option requires little or no
post-installation configuration. The server profile is created based on a set of
parameters that you enter at installation time. When the installation is complete,
the profile is created and configured based on the information that you entered.
The stand-alone server profile is configured with the relevant augmentations, and
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the WebSphere Operational Decision Management components such as Decision
Center, Rule Execution Server, Business Space and the widgets, are ready to use.
However, the sample and tutorial applications are not available.

You must select a database that you have created prior to the installation of
WebSphere Operational Decision Management. The supported databases are DB2®,
DB2 for z/0OS, Oracle, Microsoft SQL Server, and Derby Network Server.

For the Events runtime, you must also select the type of messaging service. The
options are WebSphere Application Server default messaging or WebSphere MQ.

Custom configuration: development and production

To use the WebSphere Operational Decision Management components in a
production environment, some configuration is required after completing the
installation steps for the products. The installer includes the archives to deploy and
configure Decision Center, Decision Server Rules, and Decision Server Events on
WebSphere Application Server.

For Decision Center and Decision Server Rules only, you can also install the
components on other supported application servers.

After installing the product, you must configure the applications on your chosen
application server as described in the Configuring sections of the Decision Center
and Decision Server documentation.

Installation prerequisites

Before installing WebSphere Operational Decision Management make sure that you
have the required environments and software.

Prerequisites
Before installing WebSphere Operational Decision Management, you must have the

required software installed. You can install these prerequisites using the product
launchi ad. For more information, see [“Installing from the product launchpad” on|

WebSphere Operational Decision Management has the following prerequisites:
+ IBM® Installation Manager

Installation Manager is required to install the WebSphere Operational Decision
Management packages.

¢ WebSphere Application Server Network Deployment

WebSphere Application Server is required to run the samples and tutorials.
WebSphere Application Server Network Deployment is required to install the
event runtime and Business Space widgets.

Note: Before installing WebSphere Application Server on Linux and AIX®
systems, you must set the process resource limits in the /etc/security/
Timits.conf file. If the value for the number of open files is too low, errors
might occur when opening files or establishing connections. To change the open
file limit, edit the /etc/security/1imits.conf file, and add the following values:

hard nofile 100000
soft nofile 100000

*  WebSphere eXtreme Scale
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WebSphere eXtreme Scale is required to install the event runtime. You must
install WebSphere eXtreme Scale in the directory of WebSphere Application
Server.

* IBM Business Space
Business Space is required to install the Business Space widgets.

For more information on the supported versions for these prerequisites, see
[“Software requirements.”|

Software requirements

For detailed system and software requirements, see the IBM WebSphere
Operational Decision Management support pages.

For distributed platforms:

+ |Detailed hardware and software requirements for IBM WebSphere Decision|

Server V 8.Q|

+ |Detailed hardware and software requirements for IBM WebSphere Decision|

Center V 8.{!

For the z/OS platform:
+ |Detailed system requirements for IBM WebSphere Decision Server for z/OS V|

50

+ |Detailed system requirements for IBM WebSphere Decision Center for z/0S V|

+ |Detailed system requirements for IBM WebSphere Business Rules for z/OS V|

B

The launchpad uses Installation Manager which is a 32-bit application dynamically
linked to 32-bit libraries that might not exist on some 64-bit systems such as Red
Hat Enterprise Linux (RHEL) 6.0 and 6.1. If you are using these systems, you must
install 32-bit libraries prior to using the launchpad or Installation Manager, see the
technote [Unable to install Installation Manager on RHEL 6.0/6.1 (64-bit).

Related tasks:

[“Installing a custom configuration” on page 14

Use the Custom installer to install the prerequisites that you need and select the
packages and features that you want. The Custom installer also allows more
specific installation configurations such as the installation in an existing Eclipse or
IBM product.

[‘Installing the product and the Stand-alone Server” on page 11|
Use the Stand-alone Server installer to install on a single server suitable for
development and production purposes.

Related information:

[“Installing from the product launchpad”|
Use the product launchpad to install WebSphere Operational Decision
Management as well as the prerequisite software.

Installing from

the product launchpad

Use the product launchpad to install WebSphere Operational Decision
Management as well as the prerequisite software.
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The launchpad installs IBM Installation Manager if it is not already on your
computer, and configures Installation Manager with the location of the repository
that contains the packages for WebSphere Operational Decision Management.

When you install WebSphere Operational Decision Management from the
launchpad, you select a typical installation that determines the environment
enabled after the installation. In a typical installation such as the Sample Server or
the Stand-alone Server, the launchpad installs the prerequisites for WebSphere
Operational Decision Management. It then installs the components for WebSphere
Decision Center and WebSphere Decision Server. The installer also configures these
components on a WebSphere Application Server profile.

The Sample Server installation creates a server profile on WebSphere Application
Server to run the samples and tutorials.

The Stand-alone Server installation creates a single stand-alone server profile on
WebSphere Application Server.

The following figures shows a typical installation with the launchpad on the
Sample Server or on the Stand-alone Server.

Typical installation
Launchpad
Prerequisites

l

WebSphere Operational Decision Management

| Decision Server + Decision Center

T \‘\‘q_
L2 or \
Sample Server Stand-alone Server

In the launchpad, the Custom installer provides links to install the prerequisites
manually, and then prompts you to select the features within each package that
you want to install. For example, if you want to select the archives for deploying
Rules on an application server other than WebSphere Application Server, or if you
prefer installing the help system locally rather than have the default online help.

You select the type of installation depending on your needs and requirements. The
following table shows different installation scenarios and the type of installation
that you can choose.

Table 3. Installation scenarios

If you want to ... Then choose the ...

Install the complete and ready-to-use Sample Server installer
product with no post-configuration, to test
and evaluate the product, and run the
samples and tutorials.
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Table 3. Installation scenarios (continued)

If you want to ... Then choose the ...

Install on a ready-to-use stand-alone server |Stand-alone Server installer
suitable for production, with your chosen
database, but no samples or tutorials.

Install only the components that you need. |Custom installer / Installation Manager

Extend an existing Eclipse. Custom installer / Installation Manager
Install in a compatible IBM product. Custom installer / Installation Manager
Install on a production server. Custom installer / Installation Manager

This requires some configuration after the
installation of the product.

Related concepts:

[“Installation prerequisites” on page 5
Before installing WebSphere Operational Decision Management make sure that you
have the required environments and software.

Related tasks:

[‘Installing a custom configuration” on page 14

Use the Custom installer to install the prerequisites that you need and select the
packages and features that you want. The Custom installer also allows more
specific installation configurations such as the installation in an existing Eclipse or
IBM product.

[“Installing the product and the Stand-alone Server” on page 11|
Use the Stand-alone Server installer to install on a single server suitable for
development and production purposes.

Starting the product launchpad

Start the launchpad to install the prerequisites and WebSphere Operational
Decision Management.

Before you begin

Several disks or DVDs are provided for the complete installation of WebSphere
Operational Decision Management including prerequisite software. Each DVD or
disk contains one or several components. Before starting the launchpad, make sure
that all the disks are in the same folder.

Tip: Running the launchpad directly from the DVDs can take be slow. To improve
the performance, copy the contents of the DVDs onto your computer before
starting the launchpad.

About this task

To start the product launchpad, run the executable corresponding to your
environment. The launchpad executable files are located in the root directory of the
DVDs or extracted files.

The user privileges depend on the account that you used to log in to your
computer. However, if you install the product using the launchpad Custom
installer, you can choose to install in a shared location for multiple users, or to a
single location for a specific user.

IBM WebSphere Operational Decision Management: Installation Guide



On Windows, if you want to install the product as an administrator, the user
privileges required for installing it depend on your version of Windows.

* On Windows 7: You must log in with an Administrator account to install or
update IBM Installation Manager and the other products. Alternatively, run the
installer as Administrator by right-clicking the program file or shortcut and
selecting Run as Administrator.

* On Other supported Windows versions, you must have a user ID that belongs
to the Administrator group.

Procedure
To start the launchpad:

Run one of the following executable files:
* On Windows, run launchpad.exe, or Taunchpad64.exe for a 64-bit system.

The Taunchpad.exe and Taunchpad64.exe files define the bit size that the
launchpad itself runs in.

* On Linux, run ./launchpad.sh.
What to do next

Select the type of installation that you want to perform: Sample Server, Stand-alone
Server, or Custom.

Related tasks:

[“Installing the product and the Sample Server”]

The Sample Server installer installs all of the prerequisites, as well as the packages
in the WebSphere Operational Decision Management product family. A sample
server profile on WebSphere Application Server is also created to run the samples
and tutorials.

[“Installing the product and the Stand-alone Server” on page 11|
Use the Stand-alone Server installer to install on a single server suitable for
development and production purposes.

[“Installing a custom configuration” on page 14|

Use the Custom installer to install the prerequisites that you need and select the
packages and features that you want. The Custom installer also allows more
specific installation configurations such as the installation in an existing Eclipse or
IBM product.

Installing the product and the Sample Server

The Sample Server installer installs all of the prerequisites, as well as the packages
in the WebSphere Operational Decision Management product family. A sample
server profile on WebSphere Application Server is also created to run the samples
and tutorials.

About this task

This option installs the prerequisites ( WebSphere Application Server, WebSphere
eXtreme Scale and IBM Business Space), as well as WebSphere Decision Center and
WebSphere Decision Server. The launchpad installs WebSphere Operational
Decision Management and the prerequisite software silently.

Note: If you cancel the installation before its completion, the files and folders that
have already been copied onto your computer are not deleted. You must uninstall
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the products that the launchpad has already installed using Installation Manager,
and manually delete the remaining files before running the launchpad again. For
more information on how to uninstall, see [“Uninstalling the product” on page 39

If you do not have a license for WebSphere Decision Center, you can still use
WebSphere Decision Center, but only to perform samples and tutorials.

Procedure

To install WebSphere Operational Decision Management on the Sample Server:

1. On the Welcome page of the launchpad, in the Sample Server section, click
Next.

2. Keep the default installation directory for WebSphere Operational Decision
Management or click Browse to specify a different location.

Tip: On Windows 7, the Program Files and Program Files (x86) directories
are protected. The consequence of this is that, if you are not installing the
product as an administrator, you might encounter difficulties running certain
programs. To avoid this issue, install the product in a directory other than
Program Files or Program Files (x86).

3. Enter a user ID and password for logging into the WebSphere Application
Server administration console and other applications such as Business Space.
For example:

¢ User ID: wodmadmin

¢ Password: wodmadmin

Your user ID and password must not contain any space characters.
4. Click Next.

5. Review the license agreement and notices, and select the check box to agree to
the terms.

6. At the bottom of the page, click Install Software.

During the installation, the installer might prompt you to confirm that you
want to run the Installation Manager and other installation programs, click Yes
to accept.

Important:

The installation might take a long time to complete. Do not close the launchpad
even if the progress bar shows 100% completion.

7. Wait until you get the message: Installation completed successfully

The installation of the prerequisites and WebSphere Operational Decision
Management is complete.

8. Click Close, and then click Exit.
9. Click OK to confirm that you want to exit the launchpad.

Results

By default, the product and the prerequisites are installed in the following

directories:

» WebSphere Operational Decision Management: <IBM_InstallDir>/WODM80/WODM,
where <IBM_InstallDir> refers to your IBM installation directory.
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*  WebSphere eXtreme Scale, WebSphere Application Server, and Business Space:
<IBM_InstallDir>/WODM80/WAS/AppServer, where <IBM_InstallDir> refers to your
IBM installation directory.

After running the Sample Server installer in launchpad, you have Rule Designer,
Event Designer installed on your computer. Rule Execution Server, the event
runtime, and Decision Center are also installed and ready to be deployed to the
Sample Server on WebSphere Application Server Network Deployment.

What to do next

The first time that you start the Sample Server using the start menu shortcut, a
profile is configured on WebSphere Application Server Network Deployment 8.0 to
run the included samples and tutorials in a Java EE environment, see [‘Get started

with the Sample Server” on page 37.|

Related concepts:

[“What to do next” on page 37|
Depending on your installation, you might have some configuration to do after
completing the installation of WebSphere Operational Decision Management.

Installing the product and the Stand-alone Server

Use the Stand-alone Server installer to install on a single server suitable for
development and production purposes.

Before you begin

To install WebSphere Operational Decision Management on a stand-alone server,
you must have an existing database. The product supports the following database
types for the Rules and Events repositories:

« IBM DB2 Universal Database

* IBM DB2 for z/0OS

* Microsoft SQL Server

* Oracle

* Derby Network

If you want to use WebSphere MQ as the JMS provider for the event runtime,
make sure that you have the WebSphere MQ client installed on your computer,
and that you have created the WebSphere MQ resources: queue manager name,
host, port, transport type, and channel.

About this task

In the Stand-alone Server installer, you select the components that you want to
install and for which you have a license. The Stand-alone Server option also
installs the prerequisite software to develop and deploy applications: WebSphere
Application Server, WebSphere eXtreme Scale and IBM Business Space. The
launchpad installs WebSphere Operational Decision Management and the
prerequisite software silently.

If you do not have a license for WebSphere Decision Center, you can still use
WebSphere Decision Center, but only to perform samples and tutorials.

The stand-alone server installer also prompts you to enter a set of parameters to
create a single stand-alone server on WebSphere Application Server.

Installing 11



12

Note: If you cancel the installation before its completion, the files and folders that
have already been copied onto your computer are not deleted. You must uninstall
the products that the launchpad has already installed using Installation Manager,
and manually delete the remaining files before running the launchpad again. For
more information on how to uninstall, see [“Uninstalling the product” on page 39

Procedure

To install using the Stand-alone Server installer:
1. On the Welcome page, in the Stand-alone Server section, click Next.

2. Enter the information required to install and configure Decision Center and
Decision Server:

a. Keep the default installation directory for WebSphere Operational Decision
Management or click Browse to specify a different location.

Tip: On Windows 7, the Program Files and Program Files (x86)
directories are protected, therefore if you are not installing the product as an
administrator, you might encounter difficulties running certain programs. To
avoid this issue, install the product in a directory other than Program Files
or Program Files (x86).

b. Enter a user ID and password for logging into the WebSphere Application
Server administration console and all the other applications running on
WebSphere Application Server such as Business Space and Decision Center.
For example:

e User ID: wodmadmin
* Password: wodmadmin
Your user ID and password must not contain any space characters.

C. Select the components that you want to install and for which you have a
license:

* Decision Server Rules
* Decision Server Events
* Decision Center
d. Select the method for allocating port values on the Stand-alone server:
* Recommended port values

This option ensures that the port numbers are different from any other
installations of WebSphere Application Server on the computer.

* Default WebSphere Application Server port values

This option uses the standard port numbers. However, you can run only
one instance of WebSphere Application Server using these values at a
time.

3. Click Next.
4. Specify the database to use:
a. Select the database type.
b. Enter the connection and authentication details of your database.

5. Click Test Connection to make sure that the values that you have entered are
correct.

Note: You cannot test the connection of a database on Derby Network Server.
6. Click Next.
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7. Select the type of messaging to use for internal communications in Decision
Server Events:

¢ WebSphere Application Server default messaging
* WebSphere MQ
If you select Websphere MQ, you must manually create the resources and
enter the details required.
8. Click Next.
9. Review the license agreement and notices, select the check box to agree to the
terms, and then click Install Software.

At the end of the installation, the script to create the stand-alone server profile
is started. Wait until it is completed.

Results

By default, the product and the prerequisites are installed in the following

directories:

* WebSphere Operational Decision Management: <IBM_InstallDir>/WODM80/WODM,
where <IBM_InstallDir> refers to your IBM installation directory.

e WebSphere eXtreme Scale, WebSphere Application Server, and Business Space:
<IBM_InstallDir>/WODM80/WAS/AppServer, where <IBM_InstallDir> refers to your
IBM installation directory.

After running the Stand-alone installer in the launchpad, depending on what you
have selected, you have the following components installed on your computer:

* Decision Server Rules: Rule Designer and Rule Execution Server
¢ Decision Server Events: Event Designer and the event runtime

e Decision Center: Decision Center Business Console and Decision Center
Enterprise Console.

After completing the installation of WebSphere Operational Decision Management,
the Stand-alone Server is configured, and you can start the server using the start
menu shortcut.

However, if you want to use some of the events Properties tool and legacy
connectors, you must perform additional configuration steps. For more
information, see [“Get started with the Stand-alone Server” on page 38|
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Related concepts:

[“What to do next” on page 37
Depending on your installation, you might have some configuration to do after
completing the installation of WebSphere Operational Decision Management.

[“Installation prerequisites” on page 5
Before installing WebSphere Operational Decision Management make sure that you
have the required environments and software.

Related information:

[“Installing from the product launchpad” on page 6
Use the product launchpad to install WebSphere Operational Decision
Management as well as the prerequisite software.

Installing a custom configuration

Use the Custom installer to install the prerequisites that you need and select the
packages and features that you want. The Custom installer also allows more
specific installation configurations such as the installation in an existing Eclipse or
IBM product.

About this task

You can use the Custom installer to install the prerequisites that you need, and to
select the packages for which you have a license and the features that you want to
install. In the Custom installer, you use Installation Manager to install WebSphere
Decision Center and WebSphere Decision Server.

You also have the possibility to specify the user privileges that you want to apply,
for example if you want to install in a shared location for multiple users.

Use the launchpad to verify that you have the correct versions of the prerequisites
installed. If you do not have the required software installed, use the links provided
in the launchpad to install the required software. For more information, see
[“Prerequisites” on page 5.|

Procedure

To customize your installation:
1. On the Welcome page, in the Custom section, click Next.

You can now define the user privileges for the installation, the prerequisites to
install, and start the installation of the WebSphere Operational Decision
Management packages.

2. Specify the user privileges for the installation of the prerequisites and of
WebSphere Operational Decision Management:

 If you are an administrator or root user and you want to install as a
administrative user, keep the default check box Install in a shared location
for multiple users selected.

* If you are not an administrator or if you want to install to your own user
name, clear the check box Install in a shared location for multiple users.

Note: You must install WebSphere Application Server and WebSphere
Operational Decision Management with the same user privileges. For more
information, see [“User privileges” on page 18|

3. If you do not have Installation Manager installed, click Install IBM Installation
Manager, and follow the steps in the installation wizard.
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. Click Install IBM WebSphere Application Server Network Deployment to run
IBM Installation Manager.

a. Follow the steps in Installation Manager.

Important: Do not select the option Sample applications in the WebSphere
Application Server feature tree. This prevents the event runtime from
running correctly.

b. At the end of the installation, do not open the Profile Management Tool.
No profile has been created yet.
By default WebSphere Application Server is installed in
<IBM_InstallDir>/WebSphere/AppServer, where <IBM_InstallDir> refers to
your IBM installation directory.

. Click Install WebSphere eXtreme Scale to install a supported version of
eXtreme Scale using the installation wizard.

a. Follow the steps in the installation wizard.

b. When prompted to indicate the installation directory, make sure that the
path corresponds to your WebSphere Application Server directory. For
example, C:\Program Files\IBM\WebSphere\AppServer. You must install
WebSphere eXtreme Scale in the same directory in which you installed
WebSphere Application Server.

You might get a warning on the version of WebSphere Application Server. If
you used the version of WebSphere Application Server packaged in the
launchpad, you can ignore this warning, and click Next to continue the
installation.

C. At the end of the installation, clear Launch the Profile Management Tool
console, and then click Finish.

No profile has been created yet.

. Click Install IBM Business Space powered by WebSphere to install a
supported version of Business Space using IBM Installation Manager, and
follow the steps in Installation Manager.

. After installing all the prerequisites, install the WebSphere Operational Decision
Management packages using one of the following options:

* Click WebSphere Decision Center to install only WebSphere Decision
Center.

* Click WebSphere Decision Server to install only WebSphere Decision Server.

* Click Decision Server + Decision Center to install both WebSphere Decision
Center and WebSphere Decision Server.

. Install WebSphere Operational Decision Management as described in
[[nstallation Manager” on page 20,
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Related concepts:

[“What to do next” on page 37
Depending on your installation, you might have some configuration to do after
completing the installation of WebSphere Operational Decision Management.

[“Installation prerequisites” on page 5
Before installing WebSphere Operational Decision Management make sure that you
have the required environments and software.

Related information:

[“Installing using Installation Manager”|

In Installation Manager you can choose the packages and components of
WebSphere Operational Decision Management that you want to install and for
which you have a license.

[“Installing from the product launchpad” on page |
Use the product launchpad to install WebSphere Operational Decision
Management as well as the prerequisite software.

Installing using Installation Manager

16

In Installation Manager you can choose the packages and components of
WebSphere Operational Decision Management that you want to install and for
which you have a license.

Installation Manager enables you to install only a subset of WebSphere Operational

Decision Management. In Installation Manager, you can also customize your

installation for specific configurations, for example:

* Extending an existing Eclipse.

* Installing WebSphere Operational Decision Management in another compatible
IBM product.

¢ Getting the archives for configuring on an application server other than
WebSphere Application Server.

¢ Installing the local help system.

You can use Installation Manager to install WebSphere Operational Decision
Management if you already have the prerequisite software installed, see
[‘Prerequisites” on page 5.|

The following figure shows the paths for installing using Installation Manager
through the launchpad, or directly by adding the repository locations in the
preferences of Installation Manager. If you do not have the prerequisites installed,
use the launchpad to install the software required for the components that you
want to install. However, if you have the prerequisites already installed, or if you
want to install a component that does not require any prerequisites, you can use
Installation Manager directly. For example, if you want to install only Rule
Designer.
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IBM WebSphere Operational Decision Management is split into packages, which
correspond to installable units also known as offerings:

* WebSphere Decision Center: An environment for business users to author,
manage, and test business rules and event rules.

* WebSphere Decision Server: Development and runtime environments for
business rules and business events.

To install the WebSphere Operational Decision Management packages, Installation
Manager must access the repositories that contain the packages to install. When
you use the product launchpad, Installation Manager already knows the
repositories to use to install the product. However, if you are not using the
launchpad you must specify in Installation Manager, the repository URLs for
WebSphere Decision Center and WebSphere Decision Server.

After completing the installation of the product using Installation Manager, you
still have to configure Decision Center and Decision Server to use WebSphere
Operational Decision Management in production.

Installation Manager basics

IBM Installation Manager is a tool that you use to install and maintain your IBM
products.
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When using Installation Manager you need to be aware of a few concepts such as
package groups, the shared directory, the Eclipse languages. You must also choose
the user privileges to perform your installation and understand what each role
involves.

User privileges
You can install WebSphere Operational Decision Management as an administrative
user (root) or as a non-administrative user (non-root).

Important:
You must use the same user to install the required software, for example you must

install WebSphere Operational Decision Management and WebSphere Application
Server using the same user.

For more information on the Installation Manager guidelines, see |Group road maps|
land the user interfacd and [[nstall as an administrator, non-administrator, or group|
in the Installation Manager documentation.

Administrator user

If you want the administrator user (root) to install products on a computer, run the
install executable file located in your Installation Manager installation kit.

Non-administrator user

If you want a specific user to install products on a computer, run the userinst
executable located in your installation kit.

If you want a group of users to install products on a computer, run the groupinst
executable located in the installation kit. If you install Installation Manager using
the group mode, you can install Installation Manager using one account and install
offerings using another account which is in the same group.

Note:

Group mode is not supported on Windows.

For more information, see |[nstallation commandd in the Installation Manager
documentation.

Package groups and the shared directory

Installation Manager always installs WebSphere Operational Decision Management
in a package group, which is used to group multiple packages into one
manageable location.

When installing WebSphere Operational Decision Management, Installation
Manaier i roposes a default [‘Package group”|and a [“Shared resources directory”]|

Package group

A package group is a directory where compatible packages share common
components such as a user interface or workbench.
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You can create a new package group or install the packages into an existing
compatible package group. Some packages cannot share a package group, in which
case the option to use an existing package group is disabled.

You might want to install in an existing package group if you have installed
supported versions of compatible products such as IBM Integration Designer or
Rational® Application Developer, or Rational Software Architect, and you want to
extend it with Rule Designer and Event Designer features. For more information,
see [“Installing in a compatible IBM product” on page 22

Note:

When you install several packages at the same time, all the packages are installed
into the same package group. After creating the package group, you cannot change
the installation directory. The installation directory contains files and resources
specific to WebSphere Operational Decision Management.

Shared resources directory

The shared resources directory is where Eclipse plug-ins and other files are located
so that they can be used by one or more product package groups. You can specify
the shared resources directory only the first time that you install a package. The
name of the shared resources directory depends on the first product that you have
installed.

You cannot change the directory location until you uninstall all packages.

Important: Installation Manager manages the contents of the shared resources
directory. You must not edit or modify any files in this directory.

Related concepts:

[“Installation prerequisites” on page 5

Before installing WebSphere Operational Decision Management make sure that you
have the required environments and software.

Related tasks:

[“Installing in a compatible IBM product” on page 22|
Install WebSphere Operational Decision Management in a compatible IBM product.

Languages
During the installation you can select the languages to install. English is selected
by default and it is always installed.

The languages to select only apply to Eclipse features. For each language that you
select, a language pack is installed, which allows you to start Eclipse in the locale
for these languages.

If you are extending an existing Eclipse, you must select the languages for which
you already have the language packs installed. If you select a language that is not
already installed in your existing Eclipse, you might get an error. To solve this
issue, clear the languages that are not installed in your Eclipse.

Note:
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The Rule Designer user interface is installed with all the supported locales.
Therefore, even if you do not install a certain locale, for example French, the Rule
Designer views and editors in Eclipse are still shown in this language (French) if
you start Eclipse in this locale.

Setting up Installation Manager preferences

If you have not run the launchpad, you can install the product directly using
Installation Manager.

About this task

You must manually set the repository locations in Installation Manager to retrieve
the product packages, except if you are running Installation Manager from the
launchpad.

For more information on the user privileges in Installation Manager, see
[privileges” on page 18

For general information on Installation Manager, see [[BM Installation Manager]
finformation center]

Procedure

To start Installation Manager:

1. Start Installation Manager from the Windows Start menu or from a command
line.

2. Click File > Preferences and define the repository locations for WebSphere
Decision Server and WebSphere Decision Center.

Installation Manager retrieves product packages from specified repository
locations.

For more information on how to set repository locations, see [Repository
preferences|in the Installation Manager information center.

3. On the IBM Installation Manager main page, click Install.

4. Continue the installation of the product as described in [‘Running Installation|

Related tasks:

[‘Running Installation Manager”|
After installing the prerequisites, install the WebSphere Operational Decision
Management packages using Installation Manager.

Running Installation Manager

After installing the prerequisites, install the WebSphere Operational Decision
Management packages using Installation Manager.

About this task

If you are installing this product from the launchpad Custom installer, Installation
Manager has automatically been started with the repository locations of WebSphere
Decision Center and WebSphere Decision Server.

If you are using Installation Manager directly, make sure that you have set the
repository locations as described in [“Setting up Installation Manager preferences.”]
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Procedure

To run Installation Manager:

1.

On the Install Packages page, select WebSphere Decision Center and
WebSphere Decision Server, and then click Next.

Depending on your needs, you can install one or both packages on the same
computer. For more details on the features included in each package, see
[“Selecting the features to install” on page 25|

Note: You must have both packages installed to run the Decision Center
samples and to perform the complete scenario for the Getting Started tutorials.

Review the license agreements for the selected packages, click I accept the
terms of the license agreements, and then click Next.

Only applicable if WebSphere Operational Decision Management is the first

product installed using Installation Manager. Click Next to accept the default
path for the shared resources directory.

For more information see, [‘Package groups and the shared directory” on page]

Select a package group:

a. Select Create a new package group to create a new package group for
WebSphere Operational Decision Management.

The default package group for the WebSphere Decision Center and
WebSphere Decision Server packages is WODM80 (For example, C:\Program
Files\IBM\WODM8O on Windows XP), and the name of the package group is
IBM WebSphere Operational Decision Management.

b. Click Next to continue.

For more information see, ["Package groups and the shared directory” on|
page 18 and |“Installing in a compatible IBM product” on page 22

To install a new instance of Eclipse, leave the page empty, do not select any
directory, and click Next to continue.

Installation Manager installs a new instance of Eclipse at the root of the
package group directory.

If you already have Eclipse installed and you want to use your installation of
Eclipse, see [“Installing in an existing Eclipse” on page 23|

On the Translations page, select the languages to install for this package, and
then click Next.

For more information, see [“Languages” on page 19

Select the product features that you want to install, and then click Next.

A set of features is already selected for you, by default. For more information
on the features, see [‘Selecting the features to install” on page 25/

Browse to your installation of WebSphere Application Server where you want
to deploy the WebSphere Operational Decision Management runtime, and
then click Next.

For example <IBM_InstallDir>/WebSphere/AppServer.

Enter a user ID and password for the sample server profile on WebSphere
Application Server, and then click Next. For example:

e User ID: wodmadmin
e Password: wodmadmin

Note: Your user ID and password must not contain any space characters.
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After completing the installation of WebSphere Operational Decision
Management, you use the user ID and password to connect to the WebSphere
Application Server administrative console and Business Space, and the Events
Administration Console.

10. On the Summary page, review the selected features before installing the
WebSphere Decision Center and WebSphere Decision Server packages, and
then click Install.

Tip: If you want to change anything on a previous page, click Back and
make your changes before clicking Install.

11. Wait until the installation is complete, and then click Finish.
Results

By default, the product is installed in <IBM_InstallDir>/WODM80, where
<IBM_InstallDir> refers to your IBM installation directory.

The components and features installed depend on what you have selected in
Installation Manager, see|“Checking your installation” on page 36)

What to do next

To find out what your next steps are and how to get started with your installation,
see [“What to do next” on page 37

Related concepts:

[“Troubleshooting the installation” on page 31|
If you encounter difficulties while installing the product, you can check the
installation logs or the limitations and know issues technote.

Installing in a compatible IBM product

Install WebSphere Operational Decision Management in a compatible IBM product.
About this task

When you install packages with Installation Manager, you can choose to install the
packages into an existing package group. You might want to install compatible
packages in the same package group to share functions between products and
share a common user interface.

You can install WebSphere Operational Decision Management in the package
groups of the following products:

* IBM Integration Designer

* Rational Application Developer
* Rational Developer for z (RDz)
* Rational Software Architect

Note:
Before installing WebSphere Operational Decision Management in the package

group of these products, make sure that the repository locations of these products
are not selected in the preferences of Installation Manager.
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To check the supported versions of these products, see the software requirements
for WebSphere Operational Decision Management:

* [Detailed hardware and software requirements for IBM WebSphere Decision|
Server V 8.0[

* |Detailed hardware and software requirements for IBM WebSphere Decisionl

Center V 8.Q|

Procedure

1. When prompted to select a package group in Installation Manager, select Use
the existing package group.

Installation Manager displays the list of package groups available. The package
groups that are not compatible are disabled.

2. Select the package group that you want to install in.

The installation directory is automatically filled with the path to the selected
product.

3. Continue the installation.

Related concepts:

[“Package groups and the shared directory” on page 18|

Installation Manager always installs WebSphere Operational Decision Management
in a package group, which is used to group multiple packages into one
manageable location.

Installing in an existing Eclipse

By default, when you install WebSphere Operational Decision Management,
Installation Manager installs a new instance of Eclipse. However, if you already
have a supported version of Eclipse, you can choose to extend it.

About this task

This does not apply to Eclipse instances from IBM products. To install WebSphere
Operational Decision Management in a compatible IBM product, see

la compatible IBM product” on page 22)

Installing the required plug-ins
Before installing the product in your Eclipse installation, make sure that it contains
the required plug-ins.

About this task

If you have a plain installation of Eclipse 3.6, you must install the following
additional features:

* GEF 3.6 (Graphical Editing Framework)

* EMF 2.6 (Eclipse Modeling Framework)

* BIRT 2.6 (Business Intelligence and Reporting Tools)
e DTP 1.8 (Data Tools Platform)

Rule Designer also requires WTP 3.2 (Web Tools Platform) and XSD 2.6 that are
automatically added as dependencies.

Procedure
1. Start Eclipse and navigate to Help > Install New Software.
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2. In the Install wizard, in the Work with field, select Helios -
http://download.eclipse.org/releases/helios from the list.

Eclipse checks for available features.
3. Make sure that the Group items by category check box is selected.

4. After Eclipse has downloaded available features, select the following categories
and features:

* Business Intelligence, Reporting and Charting > BIRT Framework

* Database Development > Data Tools Platform Enablement Extender SDK
* Modeling > EMF - Eclipse Modeling Framework SDK

* Modeling > Graphical Editing Framework GEF SDK

Note:

If you install a localized version of Rule Designer, you can download the
language packs for the required plug-ins from [http: / /www.eclipse.org /babel /|
[downloads.php|

5. Click Next.
Eclipse calculates the dependencies and requirements.

6. Review the items to be installed and click Next.

7. Review the license terms, and select I accept the terms of the license
agreement.

8. Click Finish to install the required components.
9. Click Restart Now if you are prompted to restart Eclipse.

Extending an existing Eclipse
Install WebSphere Operational Decision Management in an existing Eclipse.

Before you begin

Before starting the installation with Installation Manager, make sure that your
Eclipse version is compatible and that it contains the plug-ins and features
required for Rule Designer and Event Designer.

The Eclipse instance to extend must have an initialization (.1in1) file. If there is no

initialization file, you must create one in the same folder as your Eclipse .exe file.

The .ini file must have the same name as the Eclipse executable file. For example,
eclipse.exe and eclipse.ini.

About this task
You can extend an existing version of Eclipse using Installation Manager.

When you extend Eclipse, the package functions are available in your Eclipse, but
the package files are installed in the package group directory that you selected.

Procedure

1. In Installation Manager, when prompted to define your Eclipse, select the check
box Extend an existing Eclipse.

2. Browse to your compatible Eclipse IDE installation.
3. Continue the installation.
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Selecting the features to install

When you install WebSphere Operational Decision Management using Installation
Manager, you can select the features that you want within each package.

A default set of features is selected for you but you can add or remove features

depending on your needs.

» |“WebSphere Decision Center features”|

+ [“WebSphere Decision Server features” on page 27]

Installation Manager automatically enforces any dependencies between features
and prevents you from clearing these dependencies.

After you have finished installing the packages, you can still add or remove
features from your product by running the Modify Packages wizard in Installation

Manager.

WebSphere Decision Center features

The following table lists the features available for selection in the WebSphere

Decision Center package.

Table 4. WebSphere Decision Center features

Feature

Description

Decision Center

An environment for business users to
author, manage and test their business and
event rules. It includes a repository for
storing business and event rules, and web
interfaces (Decision Center Business Console
and Decision Center Enterprise Console) for
business users to manage decisions.

By default, Decision Center is installed on
the sample server profile on WebSphere
Application Server. After completing the
installation of the product, you can also
configure and deploy Decision Center on a
different WebSphere Application Server
profile, or install it on other supported
application servers. However, the Decision
Center Business Console is supported on
WebSphere Application Server V8.0 only.

Decision Center: Installation artifacts for
other application servers > Decision Center
for Tomcat

Decision Cente

Provides the archives to deploy and
configure Decision Center on Tomcat. The
archives are copied to <InstallDir>/
teamserver/applicationservers/tomcat.

For more information, see [Configuring|

Decision Center: Installation artifacts for
other application servers > Decision Center
for JBoss

Decision Cente

Provides the archives to deploy and
configure Decision Center on JBoss. The
archives are copied to <Instal1Dir>/
teamserver/applicationservers/JBoss.

For more information, see |[Configuring
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Table 4. WebSphere Decision Center features (continued)

Feature

Description

Decision Center: Installation artifacts for
other application servers > Decision Center
for WebLogic

Provides the archives to deploy and
configure Decision Center on WebLogic. The
archives are copied to <InstallDir>/
teamserver/applicationservers/WebLogic.

For more information, see |Configuringj

Decision Center for Business Space >
Decision Widget

The Decision widget is available from
Business Space and is similar to the Decision
Center Enterprise Console.

Before you can use the Decision widget, you
must configure the Decision widget for
Business Space. For more information, see
|Configuring Decision Center]

Decision Center for Business Space > Event
Capture and Replay Widgets

In the Event Capture widget and the Event
Replay widget you capture events from a
production system, and replay a sequence of
one or more of them, typically on a test
system.

Before you can use these widgets, you must
also configure Business Space. For more
information, see [Configuring Decision Server]

Decision Center for Business Space > Event
Charting Widgets

Event Charting Widgets include the Event
Chart Manager widget to create and edit
charts, the Event Chart widget to view
charts as well as real-time charts which
display the history for events, actions, and
filters, and the Event Layout widget to view
legacy layouts.

Before you can use these widgets, you must
also configure Business Space. [Configuring]

[Decision Server Events|

Decision Center for Business Space > Event
Tester Widget

The Event Tester Widget provides a way to
test the event logic in a business process.
This widget is aimed at testing and should
be used only on a test installation. Do not
use it on a production installation as it
might affect performance.

Before you can use this widget, you must
also configure Business Space. [Configuring]

[Decision Server Events|
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Table 4. WebSphere Decision Center features

(continued)

Feature

Description

Rule Solutions for Office (for Windows
only)

Rule Solutions for Office provides a way for
business users to create and edit business
rules in Microsoft Word or Excel.

This option copies the installer for Rule
Solutions for Office to your installation
directory. The executable file for the installer
is copied to: <InstallDir>/Rule Solutions
for Office/RuleSolutionsForOffice.exe,
see ["Installing Rule Solutions for Office” on|

|page 35.|

Samples and Tutorials

Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.

Local help system

By default this feature is not selected
because the help system points to the online
information center.

You can select the Local help system option
if you prefer accessing the help contents
locally. To use the local help system, you
only need an Internet connection the first
time to download the help contents from the
web. After downloading the help contents,
you must set up the local help. For more
information on how to set up the local help,
see [“Installing and accessing the|
|documentation locally” on page 32|

WebSphere Decision Server features

The following table lists the features available for selection in the WebSphere

Decision Server package.

Table 5. WebSphere Decision Server features

Feature

Description

Decision Server Rules

Rule Designer

Rule Designer is a development environment
within Eclipse to design business rule
applications. It is aimed at developers,
business analysts, and architects. The Rule
Designer views and editors are available from
the Rule perspective in Eclipse.

Rule Designer > Scorecard Modeler

Scorecard Modeler is a set of additional
plug-ins integrated into Rule Designer. You
can use Scorecard Modeler to create
scorecards, integrate them into your business
rules, and share them across multiple
platforms.
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Table 5. WebSphere Decision Server features (continued)

Feature

Description

Rule Execution Server

Rule Execution Server is an execution
platform for business rules that embeds the
rule engine. It also provides a console to
manage and monitor the execution of
business rules.

By default, Rule Execution Server is installed
on the sample server profile on WebSphere
Application Server. After completing the
installation of the product, you can also
configure and deploy Rule Execution Server
on a different WebSphere Application Server
profile, or install it on other supported
application servers.

Select the type of license that you have:

* Non-production License: Select this option
if you want to use the product for
development purposes.

This license can only be deployed as part
of development and test environment for
internal non-production activities.

* Production License: Select this option if
you want to use the product for
production.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for Tomcat

Provides the archives to deploy and configure
Rule Execution Server on Tomcat. The
archives are copied to <InstallDir>/
executionserver/applicationservers/tomcat.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see |Configuring Rule

|Execution Servej

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for JBoss

Provides the archives to deploy and configure
Rule Execution Server on JBoss. The archives
are copied to <InstallDir>/executionserver/
applicationservers/JBoss.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see [Configuring Rule

|Execution Servej

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for WebLogic

Provides the archives to deploy and configure
Rule Execution Server on WebLogic. The
archives are copied to <Instal1Dir>/
executionserver/applicationservers/
WebLogic.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see |Configuring Ruld

|Execution Serveﬂ

Decision Server Events

WebSphere Application Server is a
prerequisite for Decision Server Events.
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Table 5. WebSphere Decision Server features (continued)

Feature

Description

Event Designer

A development environment within Eclipse
to design, develop, test, deploy, and monitor
event applications. Event Designer is
available from the Event perspective in
Eclipse.

Event Flow

Event flow diagrams consist of event rule
groups and business steps that compose a
business process.

Runtime > Event Runtime

The event runtime is an execution platform
that manages real-time business event
coordination. The event runtime requires
WebSphere eXtreme Scale and must be
deployed and configured on WebSphere
Application Server.

Select the type of license that you have:

* Non-production License: Select this option
if you want to use the product for
development purposes.

This license can only be deployed as part
of development and test environment for
internal non-production activities.

¢ Production License: Select this option if
you want to use the product for
production.

Runtime > Event Connectors (Legacy)

Event connectors provide data connections
between the event runtime and external
systems. Legacy connectors include email
and ftp.

Event Capture and Replay Widgets

In the Event Capture widget and the Event
Replay widget you capture events from a
production system, and replay a sequence of
one or more of them, typically on a test
system.

Before you can use these widgets, you must
also configure Business Space. For more
information, see [Configuring Decision Server|

Event Tester Widget

The Event Tester Widget provides a way to
test the event logic in a business process. This
widget is aimed at testing and should be
used only on a test installation. Do not use it
on a production installation as it might affect
performance.

Before you can use this widget, you must
also configure Business Space. For more
information, see|Configuring Decision Server|

Integration Components

You can install integration components into
the tooling of WebSphere ESB and WebSphere
Message Broker to allow these products to
send and receive data from Decision Server
Events.
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Table 5. WebSphere Decision Server features (continued)

Feature | Description

Shared components

Samples and Tutorials Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.

Update sites for installation into other Provides ZIP files containing the Eclipse
Eclipse products update sites (and a copy of the Designer
plug-ins) to install Rule Designer and Event
Designer features into an existing Eclipse.
This provides an alternate way of installing
the Designer plug-ins into a supported
Eclipse after the installation of WebSphere
Operational Decision Management.

For more information, see [Extending Eclipse|
[with the Rule Designer update sited.

Local help system By default this feature is not selected because
the help system points to the online
information center.

You can select the Local help system option
if you prefer accessing the help contents
locally. To use the local help system, you only
need an Internet connection the first time to
download the help contents from the web.
After downloading the help contents, you
must set up the local help. For more
information on how to set up the local help,
see |“Installing and accessing the|
|documentation locally” on page 32.|

Installing in silent mode

30

You can install the WebSphere Operational Decision Management product
packages by running Installation Manager in silent installation mode to automate
processes, deploy software to multiple systems, or to an enterprise.

About this task

When you run Installation Manager in silent mode, the user interface is not
available. Installation Manager uses a response file that contains the commands
required to install the product package.

Running Installation Manager in silent mode enables you to automate a process to
install, update, modify and uninstall product packages through scripts.

You can also install Installation Manager silently using the Installation Manager
installer, and then use the installer to install silently the product packages. For
more information, see|Use the installer package to install Installation Manager|
fusing the user interface or silent install.
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The launchpad provides sample response files that you can use to build your own
response files. These response files are located in the responsefiles directories of
your installation kit. Make sure that all the disks are in the same location. If the
disks are not in the same location, the installer prompts you for the location of
each disk.

Note: On Windows 7, if you install in silent mode as a regular user, you are
prompted to accept the security certificates for each product. To avoid this issue,
you can run the installer as an administrator (right-click the file and select Run as
Administrator).

Procedure

To install in silent mode:

1. Create a response file.

For more information, see in the Installation Manager

information center.
2. Run Installation Manager in silent mode.

For more information, see [Install packages silently by using the Installation|
[Manager installer]in the Installation Manager information center.

Troubleshooting the installation

If you encounter difficulties while installing the product, you can check the
installation logs or the limitations and know issues technote.

You can find general information on Installation Manager and how to use it in the
IBM [Installation Manager information center|

When contacting IBM support, make sure that you have the following information
at hand:

* Version of Installation Manager installed

* Offerings installed and these version numbers
* Operating System

¢ Installation Manager logs

Installation logs

If you have difficulties installing the product through Installation Manager,
retrieve the installation logs to find out more information on the issues
encountered.
* Installation Manager:
— Windows 2000, XP, and 2003: C:\Documents and Settings\Al1l
Users\Application Data\IBM\Installation Manager\logs
— Windows Vista,7, and 2008: C:\ProgramData\IBM\Installation
Manager\logs\.settings\logs
— UNIX: /var/ibm/InstallationManager/logs

For more information, see [Finding IBM Installation Manager|
[troubleshooting logs|

* Launchpad:
— Windows: $TEMP%\IBM_LaunchPad_<InstallType>\
%TEMP% is the environment variable that defines the location of your
Temp directory. <InstallType> refers to the type of installation that you
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selected. If the launchpad fails before even starting the installation, no
installation type is indicated in the folder name.

— UNIX: /tmp/IBM_LaunchPad_<InstallType>/
Limitations and known issues

To find a list of the current limitations and known issues, check the
technote [Known limitations in WebSphere Operational Decision|
Management V 8.0|

Installing and accessing the documentation locally

32

By default, the help system connects to the online information center. However,
you can install the documentation locally if you select the Local help system
option in Installation Manager.

Installing the product documentation on your computer

To install the local information center, you must first start the help system that you
installed by selecting Local help system option in Installation Manager.

Before you begin

By default, the help system connects to the online information center. You do not
have to do anything if you want to use the online help. However, you can install
the documentation locally on your system. For example, if you want to view the

documentation offline or on a computer that does not have an Internet access. To
install the documentation locally, you must make sure that you have selected the
Local help system option in Installation Manager. Then, you must configure the

help system.

If you have selected the Local help system option, the help system for the product
is installed on your computer and you can install a local copy of the entire
documentation set.

About this task

To install this stand-alone help system that can access help contents locally, you
have to download the help contents using an Internet connection. The Internet
connection is only required the first time to download the help contents from the
web.

Procedure

To install the documentation locally:
1. Do one of the following steps:

* In the Start menu, click All Programs > IBM > package_group >
Information center for WebSphere Operational Decision Management
(Iocal).

package_group refers to the package group specified in IBM Installation
Manager during installation. The default package group is WebSphere
Operational Decision Management.

* Run the following script:
— <InstallDir>/doc/help_start.bat on Windows
— <InstallDir>/doc/help_start.sh on Linux.
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Note: To run the information center in a locale other than English, you must
add the locale argument (-n1 xx_XX) to the <InstallDir>/doc/
help_start.bat or <InstallDir>/doc/help_start.sh file, before the -vmargs
argument. For example:

-eclipsehome eclipse -nl1 fr_FR -configuration configuration_iehs

A new browser window opens. The documentation is not available yet,
because you have not downloaded the help contents.

2. Click £2 Update in the help toolbar.
A list of the documentation sets already installed is displayed.
3. Click Next.

A list of the documentation sets available for installation is displayed. The list
includes documentation sets in English and other supported languages, as well
as documentation for other products.

4. Select the documentation sets that you want to install.
5. Click Install.
The Update wizard installs the documentation contents.

A note is then displayed to warn you that the installation might take some time
to complete.

6. Click OK, then click Finish.
The help contents are installed in the help system on your computer.
7. Refresh the page to view the documentation.

Results

The documentation contents are now installed locally and is available the next time
you start the documentation from the Start menu shortcut.

Accessing the local contextual help in Rule Designer

To access the local help system from Rule Designer you must first install the
documentation locally.

Before you begin

If you want to access the documentation locally rather than online in Rule
Designer, make sure that you have selected the Local help system option in
Installation Manager. You can modify the options selected in Installation Manager.
After installing the documentation locally you no longer need an Internet
connection to access the local information center. For more information, see
[“Installing the product documentation on your computer” on page 32)

Remember: If you do not have specific needs for using local help rather than
online help, you do not have to select the Local help system option in Installation
Manager. By default, the online help is activated and no configuration is required.

About this task

To use the local contextual help from Rule Designer, you must start the local
instance of the information center. The installer inserts the necessary parameters to
access the help from Rule Designer.

If you want to change the parameters to point to a different instance of the
information center, for example a shared information center server running on an
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internal network, you can modify the values in Rule Designer.
Procedure

To access the local help in Rule Designer:
1. Check that the settings to use the local help are set correctly in Rule Designer:
a. Click Window > Preferences > Help > Content.
b. Make sure Include remote help and give it priority is selected.
C. Select the link to the information center and click Edit.
d. Make sure that the local information center has the following values:
¢ Name: WebSphere Operational Decision Management information center
* Host: Tocalhost
* Path: /help
e Use port: 3333
e. Click OK, and then click Apply and OK.
2. Start the local help:

* In the Start menu, click All Programs > IBM > package_group >
Information center for WebSphere Operational Decision Management
(Iocal).

* Run the <InstallDir>/doc/help_start.bat (Windows) or
<InstallDir>/doc/help_start.sh (Linux)
3. On the Help menu, click Help Contents.
If you have already installed the documentation, the local information center

for the WebSphere Operational Decision Management product family, Decision
Center, and Decision Server is displayed.

If the documentation has not been installed, follow the steps as described in
[“Installing the product documentation on your computer” on page 32|

Running a shared information center on an internal network

You can run the information center on an internal network.
Before you begin

Before running the information center on an internal network, make sure that you
have installed the documentation locally as described in [“Installing the product]
[documentation on your computer” on page 32]

About this task

If you have selected the Local help system option, you can set the help system up
so that the information center runs on an internal network.

Procedure

To start the information center on an internal network:

1. Run <InstallDir>/doc/IC_start.bat on Windows or <InstallDir>/doc/
IC start.sh on Linux.

By default, the shared information center runs on port 9999.

2. Optional: To modify the default port, edit the IC_start.bat or IC_start.sh file,
and modify the port argument. For example, -port <port_number>.
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When the shared information center is started, it is accessed using browsers
from other systems at the address http://<hostname>:<port>/help.

Note: To access different locales in the information center, specify the locale at
the end of the URL. For example, http://<ic_hostname>:9999/help/
index.jsp?lang=xx_XX

The locales include de_DE, es_ES, fr_FR, it_IT, ja_JP, ko_KR, pl_PL, pt_BR,
ru_RU, zh_CN, and zh_TW.

3. Optional: Configure the help preferences in Rule Designer to access the
information center:

a. Click Window > Preferences > Help > Content.
b. Select Include remote help and give it priority, then click New.

c. Enter the values for the information center that you want to connect to, for
example:

* Name: WebSphere Operational Decision Management information center
* Host: <ic_hostname>
* Path: /help
e Use port: 9999
d. Click OK, and then click Apply and OK.
The contextual help now uses your new parameters.

Stopping the local help

Before uninstalling the WebSphere Operational Decision Management offerings in
Installation Manager, you must stop the information center process to avoid
encountering uninstallation issues.

To stop the local information center:
¢ On Windows, run <InstallDir>/doc/help_end.bat.
* On Linux, run <Instal1Dir>/doc/help_end.sh.

To stop the shared information center:

* On Windows, run <InstallDir>/doc/IC_end.bat.
* On Linux, run <Instal1Dir>/doc/IC_end.sh.
Related tasks:

[‘Uninstalling the product” on page 39
To uninstall the product after using the launchpad or Installation Manager, you
must uninstall each product separately and in a specific order.

Installing Rule

Solutions for Office

After completing the installation of Decision Center using the launchpad or
Installation Manager, you must manually run the installer for Rule Solutions for
Office.

Before you begin
If you installed the product using Installation Manager, make sure that you

selected the Rule Solutions for Office feature, see ['Selecting the features to|
finstall” on page 25.
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You must have a supported version of Microsoft Office to install Rule Solutions for
Office.

About this task

Rule Solutions for Office is an optional component that provides a way for
business users to create and edit business rules in Microsoft Word or Excel. The
Rule Solutions for Office feature in Installation Manager copies the installer for
Rule Solutions for Office to your installation directory.

Procedure
1. Navigate to <InstallDir>/Rule Solutions for Office/
2. Double-click the RuleSolutionsForOffice.exe file to run it.

3. Follow the steps in the installation wizard.

Checking your

installation

You can find out what components of WebSphere Operational Decision
Management you have installed through the launchpad and Installation Manager,
by looking at the installation directory.

After running the launchpad or Installation Manager, you can check what
components you installed by looking at the <Instal1Dir> folder on your computer.
The folders under <InstallDir> can be used to identify the components and
features of WebSphere Operational Decision Management. Use the table below to
help you identify what is installed on you computer:

Table 6. Component-folder mapping

Component Folders

Decision Server Rules

Rule Designer studio

Rule Execution Server executionserver
Folders common to Decision Server Rules gettingstarted, dotnet
components

Decision Server Events

Event Designer connectors, runtime, widgets

Decision Center teamserver, decisionWidget, Rule Solutions
for Office (optional)

Setting up your environment to automate processes

You must ensure that you have the correct version of Ant and that it is configured
correctly.

About this task

You must have version 1.7.1 (or later) of Ant correctly set up on your system to
deploy RuleApps to Rule Execution Server, automate managerial tasks within
Decision Center, and run many of the samples. If Ant is not installed, or your
version is older than version 1.7.1, you must set up your environment to use the
correct version of Ant. You can download Ant from fhttp://ant.apache.org/} or you
can use the Ant 1.7.1 distribution packaged at <InstallDir>/shared/tools/ant.
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Procedure

To test and set up your environment to use Ant:

1. Test your current version of Ant by typing the following in a Windows
Command Prompt or UNIX shell:

ant -version
2. Set the ANT HOME environment variable to <InstallDir>/shared/tools/ant.

3. Set the JAVA_HOME environment variable to the path to your JDK installation
(1.6).

4. Add the directory <InstallDir>/shared/tools/ant/bin to your PATH
environment variable.

What to do next

Depending on your installation, you might have some configuration to do after
completing the installation of WebSphere Operational Decision Management.

* Sample Server installation: No configuration is required, see [“Get started with|
[the Sample Server.”]

* Stand-alone Server installation: No configuration is required except for certain
Events features, see [‘Get started with the Stand-alone Server” on page 38)

* Custom installation: You must configure the WebSphere Operational Decision
Management components for a production environment, see
[application in production” on page 38

Get started with the Sample Server

The first time that you start the Sample Server, a profile (WODMSample) is
configured on WebSphere Application Server Network Deployment V8.0 to run the
included samples and tutorials in a Java EE environment. You can start the sample
server using the start menu shortcut:

On the start menu, click All Programs > IBM > package_group > Sample Server >
Start server. package_group refers to the package group specified in IBM Installation
Manager during installation. The default package group is WebSphere Operational
Decision Management V8.0.

The profile creation takes several minutes to complete. Wait until the build has
successfully completed.

You can perform a number of introductory tasks using the environment that is
installed for you by the Sample Server installer:

¢ Perform the Getting Started tutorials, and other component specific tutorials.
* Run the samples from the Samples Console in Eclipse.

* Test and simulate your rule projects against scenario data.

* Test the event runtime.

Note:

 If you are using the Sample Server profile to run Events, you will also use the
same username and password to login to Business Space and to the Events
administrative console.

* Single sign-on (SSO) authentication is activated for the Sample Server. SSO
allows users to log in once and gain access to all applications without being
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prompted to log in again for each of them. If you use different sign-on
credentials for the applications on the Sample Server, for example when
performing certain samples and tutorials, you get an error message when you
attempt to sign in to the second application.

To avoid this issue, you must sign out of the first console and then sign in to the
second console. Alternatively, you can sign in to all of the applications on the
server using the credentials that you entered at installation time.

For more information on the Sample Server and how to use it, see

Sample Serve

Get started with the Stand-alone Server

After running the launchpad using the Stand-alone Server installer, you can start
the stand-alone server using the start menu shortcut:

On the start menu, click All Programs > IBM > package_group > Stand-alone
Server > Start server.

package_group refers to the package group specified in IBM Installation Manager
during installation. The default package group is WebSphere Operational Decision
Management V8.0.

Important: To use the Events Properties tool (propertiesui) and legacy connectors
(email and ftp), you must perform some additional configuration steps. For more
information, see [Configuring the event runtime environment| including |Editing thel
lsetenv fild and [Configuring multiple Decision Server Events profiles to coexist|

Use your application in production

Rule Designer and Event Designer are installed and you can start designing your
application in Decision Server.

Depending your company’s needs and on the components of WebSphere
Operational Decision Management that you want to use, some configuration is
required:

* To execute your rule-based application, see [Configuring Rule Execution Server]

* To execute iour application using event processing, see [Configuring Decision|

Server Events

» For business users to edit and test rules in Decision Center, see [Configuring]
[Decision Center]

* To execute your application on a z/OS platform, install the required additional
files using the SMP/E tool, and see [Configuring Decision Server for z/OS|

e For business users to edit and test rules in Decision Center for z/0OS, install the
required additional files using the SMP/E tool, and see [Configuring Decision|
[Center for z/OS|

To get a better understanding of the development lifecycle using WebSphere
Operational Decision Management, see|Business rule application development]
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http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.dserver.events.config/topics/wodm_dserver_events_config.htm
http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.dcenter.config/topics/wodm_dcenter_config.htm
http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.dcenter.config/topics/wodm_dcenter_config.htm
http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.zos.dserver.config/topics/wodm_zos_dserver_config.htm
http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.zos.dcenter.config/topics/wodm_zos_dcenter_config.htm
http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.zos.dcenter.config/topics/wodm_zos_dcenter_config.htm
http://submit.boulder.ibm.com/infocenter/idwb/v3r8m4/topic/com.ibm.ditaepic.doc/../com.ibm.wodm.family.overview/topics/tpc_dmov_intro_dmrulesdev_intro.htm

Related tasks:

[‘Installing the product and the Sample Server” on page 9

The Sample Server installer installs all of the prerequisites, as well as the packages
in the WebSphere Operational Decision Management product family. A sample
server profile on WebSphere Application Server is also created to run the samples
and tutorials.

Uninstalling the product

To uninstall the product after using the launchpad or Installation Manager, you
must uninstall each product separately and in a specific order.

Before you begin

Before uninstalling the product, make sure that you have stopped all the
applications that run with the product including the server, any instance of Rule
Designer or Event Designer, and the local help process if enabled.

To uninstall the packages, you must log in to the system using the same user
account that you used to install the product packages. Make sure that you are
using the correct instance of Installation Manager to uninstall the product:

* If you installed the products as an administrator, you must uninstall using the
administrator instance of Installation Manager, which is accessible through the
IBM Installation Manager start menu shortcut.

e If you installed the products as a non-administrator user, you must uninstall
using the non-administrator instance of Installation Manager, which is accessible
through the My IBM Installation Manager start menu shortcut.

A package cannot be uninstalled when another package has a dependency on it,
unless the dependent package is also selected to be uninstalled.

About this task

You must uninstall each product separately and in a specific order. You can use
Installation Manager to uninstall the products except for WebSphere eXtreme Scale.

Procedure

To uninstall the products:
1. Close the programs that you installed using Installation Manager.

2. Uninstall WebSphere Decision Center and WebSphere Decision Server using
Installation Manager.

For more information on how to uninstall using Installation Manager, see
[Uninstall packages by using wizard mode|in the Installation Manager
information center.

3. Uninstall WebSphere eXtreme Scale using the installation program wizard, see
[Uninstalling WebSphere eXtreme Scale|in the WebSphere eXtreme Scale
information center.

Important:

You must uninstall WebSphere eXtreme Scale before uninstalling WebSphere
Application Server and Business Space.
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4. Uninstall Business Space and WebSphere Application Server using Installation
Manager.

The uninstallation might take some time to complete.

For more information on how to uninstall using Installation Manager, see
[Uninstall packages by using wizard mode|in the Installation Manager
information center.

Related concepts:

[“Stopping the local help” on page 35

Before uninstalling the WebSphere Operational Decision Management offerings in
Installation Manager, you must stop the information center process to avoid
encountering uninstallation issues.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England SO21 2JN

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England SO21 2JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
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imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at ’
trademark information|’ at www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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